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2.

INTRODUCTION

Your Macintosh + The Print Shop =a stationery store in
your own horne.

The Print Shop is the program Macintosh users have been waiting for! It
helps you fully utilize all the graphic capabilities of the Macintosh to quickly
and easily design and print out your own:

• Greeting Cards
• Invitations and Announcements
• Stationery and Letlerhead
• Banners
• Signs
• ... and much more!

Designs that would require hours of time-consuming cutting and pasting
without The Print Shop take just minutes to design and print with The Print
Shop.

The Print Shop is so easy to use you'lI be printing out designs in minutes.
Simply make your choices from the menus and windows on your screen. Pick
out a ready-made design or create your own. Choose graphics fram a wide
selection provided with the program or use art fram any MacPaint file. Add
your own drawings, images fram graphics collections, digitized graphics, etc.
Your choices are just about unlimited.

You can brighten your projects by using colored paper and color ribbons.
And, with the ImageWriter 11, you can even print projects with multicolored
designs.

USING THIS MANUAL The Print Shop has been especially designed to take advantage of the
Macintosh format. You can type your message, pick a border, or add a graphic
at any time you want. You can design and redesign with a click of the mouse
and experiment until your praject is just the way you want it.

This manual will introduce you to The Print Shop's capabilities and help
you learn how to use all the diHerent features The Print Shop has to oHer.
Use it as a guide to answer any questions that may arise as you work on your
projects.

Read the Getting Ready section of the manual if you want abrief
refresher of Macintosh terms and operations. This section also discusses
making backup copies.

A Quick Start will help you begin quickly by giving you an overview of
all the important features to be found on the four Main Project screens and on
the Menu Bar.

The Graphics Menu reviews all the graphics options you may want to
use in your project. The options-ijraphic selection, editing, layout,
etc.-work the same way in all The Print Shop projects (greeting cards, signs,
letterhead, and banners) so you'lI use the Graphics Menu to choose and
design graphics for whatever you create. All the graphics features are
discussed in this section. If you have any questions about graphics or get
stuck at any point, look to this section for help. It will guide you through the
process of choosing art from The Print Shop Graphics collection, as weil as
from MacPaint files, of editing the graphics to suit your needs, and of laying
out the artwork in your design.



For specific help on any project, turn to the project sections-Greeting
Card and Sign, Banner, or Letterhead.

When you are ready to print, Printing Your Project will give you
directions on checking paper alignment, selecting color printing, and printing
with the ImageWriter or LaserWriter.

Finally, Special Features gives special tips and suggests additional
options to help you get the most out of The Print Shop.
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1. GETTING READY

THE PRINT SHOP INCLUOES • One Print Shop program disk
• The Print Shop manual
• Quick Reference Card
• Colored pinfeed paper and envelopes

WHATYOU WILL NEEO Required:
• 1MB Macintosh, Macintosh Plus, or Macintosh SE, SE30, 11, IIX, IICX
• Printer (ImageWriter I or 11, LaserWriter or any 100% compatible printer)

Optional:
• External disk drive
• Colored ribbon for the ImageWriter 11

Note: If any of the Macintosh terms used in the following paragraph~

are unfamiliar to you, see Reviewing Macintosh Terms, page 6, for a brie
review of their definitions.

MAKING A BACKUP COPY It is a good idea to make a backup copy of your Print Shop disk and use
your copy rather than the original while working with the program. You can
make a backup copy the same way you make copies of MacWrite or MacPain
Simply:

1. Insert your original Print Shop disk into your Macintosh.

2. Once it has loaded and the disk icon has appeared on the desktop,
insert the disk you wish to use as a backup. If it is an unformatted disk, follow
the on-screen prompts to format and name your disko

3. Drag the icon ofThe Print Shop disk across the desktop until it covers
the icon of your backup disko A dialog box will appear verifying that you wish tc
replace the contents of the backup disko If this is correct, click OK. When the
backup disk is complete, you can name the backup disk and use it instead of
the original.

4. Store the original Print Shop disk in a safe and convenient place.

STARTING THE PROGRAM If your computer is off: Turn your computer on, insert the Print Shop pro-
gram disk into the internal drive.

If your computer is on: Eject any disks currently in the drive. Turn the POw€
off and then on again. Insert the Print Shop program disk in the internal drive.

4



Your Desktop Here is what your desktop will look Iike when you open Print Shop 1 for
the first time. The Print Shop program icon and System Folderwill appear.

File Edit Uiew Special

The Print Shop-double-c1ick this icon to
start The Print Shop program.

PS Graphics---eontains all the graphics
provided wilh The Prinl Shop program.

A MacPainl File---eontains some MacPainl
graphics you can use with The Prinl Shop.

PS Fonts---eonlains all the fonls provided
wilh The Prinl Shop program.

PS Borders---eonlains all the borders
provided wilh The Prinl Shop program.

..

Ready-made Folder-conlains pre-designed
cards, banners, signs and lelterheads.

5



REVIEWING MACINTOSH
TERMS

If you've been using other Macintosh programs, The Print Shop's
operation should seem familiar to you. Here's a briet review of some
Macintosh terms and features you'lI use with The Print Shop:

----------

Borders J I fl@ody=ooode I

Spael"9 AI19"",.nl

IZI Plaln

o Bold

o /i~11c

• File [dU Selections Grophics Fonts FontSlze

Untitled

Buttons _---V-------------n

Pointer

Serail Bar

Menu Bar

Pointer The small black arrow you use to "point" at things on the screen. You
move the pointer by moving your mouse on your desk or pad.

Mouse Operation 1. Clicking: Clicking is used to select items that appear on the screen. To
dick, position the pointer over the item you want, then press and quickly
release the mouse button.

2. Pressing: Pressing and holding the mouse button causes a
continuous action. To press, position the pointerwhere you want it, then
hold the mouse button down. For example, press the arraws at the top or
bottom of the serail bar to serail.

3. Dragging: Move items from one place to another on the screen by
"dragging" them. To do this, position the pointeroverthe item you want to
move, then press the mouse button. Holding the button down, "drag" the
item to its new location by moving the mouse across your desktop. When the
item has moved to where you want it, release the mouse button.

4. Highlighting: Select text for editing tunetions by "highlighting" it. To
highlight text, position the pointer to the left of the text to be highlighted,
press the mouse button and drag the pointer over the text.

Buttons Circles or rectangles with labels in them. When you want to perform the
action or select the item described by the label, dick the button with the
mouse. Buttons and menu items that are grayed-out cannot be used.

Menu Bar The white strip across the top of your screen. The title ot each menu is
written on the menu bar. You choose trom a menu by positioning the pointer
on the menu title, pressing the mouse button, then dragging to the
command you want and releasing.
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Dialog Boxes In many cases, when you select an item, a dialog box will appear on the
screen. In some dialog boxes, you dick buttons to change or confirm
choices; other boxes simply provide information. When you have finished
making selections in a dialog box, click "OK" to signal that you are done. Click
"Cancel" to return to where you were without taking any action.

Scrall Bars Scroll bars let you view all the contents of a window when those contents
are too long to fit on the screen. Arraws are located at the ends of a scroll bar.
The area between the arrows represents the full window. You can view
different areas of the window by scrolling.

1. To scroll slowly, dick one of the arrows.

2. To scroll continuously, press one of the arrows.

3. To scrall more quickly, dick the area between the arrows or drag the
scroll box to a new position.

Creating and Editing Tex1 In general, you can type and edit text for your prajects as you would using
MacWrite.

The text you type will appear at the blinking cursor on your screen.

1. To move the cursor within a line use the Backspace key and the space
bar.

2. To start a new line, press Return. To move up a line, press Backspace.

3. To erase text, simply move the cursor to the right of the text you wish
to delete. Then press Backspace. Or highlight all the text to be deleted and
press Backspace.

You can choose a typeface and typesize from the Font and FontSize
Menus and a typestyle fram the typestyle boxes that will be available as you
work on your project. You can also choose the spacing and alignment of the
text.

Make all your type selections first, then begin typing and see how your
choices look. To make changes in the typeface, size, or style of
text you have already typed, first highlight the text to be
changed. Then make your new font and typestyle choices. The highlighted
text will change on the screen. When you are satisfied with your choices, dick
the mouse to remove the highlight. Move your cursor to wherever you wish to
continue typing.

If you insert a word or words within previously typed text, the new word or
words will match the surraunding text. If you wish to use a different typestyle,
simply move your cursor to the place where you wish to make your insertion,
then make your new font and typestyle selections and begin typing.

If you erase tex1 by mistake or simply want to cancel your last action,
select Undo from the Edit Menu before doing anything else.
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2. A QUICK START

This section will give you an overview of all the important features to be
found on the four Main Project screens and on the Menu Bar. Use it if you want
to get started quickly. Once you've worked on some projects and gained some
hands-on experience, you can come back to the manual for more information.

OPENING THE PRINT SHOP Load the Print Shop program disk following the directions given under
"Starting the Program:' Select !T:fZI on your desktop. Double-click on the icon

to open The Print Shop program. The Project Selection screen will appear.

Opening Your Project Move the pointer to one of the four icons-Sign, Letterhead, Banner, or
Greeting Card. Double-click to begin working on the project of your choice.

• File [dit Selectlons l;mphil;~ FDnts fontSlzl'
11

o Underl ine

o QII

o IIiliIQ!IIIII

Spoc:lng

Greeting Card

181 Plaln

o Bold

o It<3li<:

• File [dit Selectlons Graphics Fonts FontSlze

i!O Untltled

THE MAIN PROJECT
SCREENS

GREETING CARD

Move up ordown scroll bar to __--U------------__= @Fronl

see entire card panel. ===-~-----------==l~O_I_ns_ld_e _

Click to see front or inside of card. ====ll----------====+= Cr.di l )L..-..:::8oI=-def=-:s::::::-.J- Ir--Re-ody-:--..od-:-.-')
Click to add your own credit -='"_~ _

line to appear on card.

Click to choose a different border.

Click to choose a ready-made card.

Click on/off one or more
boxes to choose typestyles.

Click one box to choose
spacing of type lines.

Click one box to choose type
alignment -Iett, center, right.
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FonlSize• File Edll ele~lIons

10
SIGN

Move Up or down scroll bar to see entire sign. ----tt--------.......-------

Click to choose a ready-made sign. -----jtt-----------------F=-------_=_.

Click one box to choose type alignment­
lett, center, right.

Click to choose a different border._--~U---------------T~

Click on/off one or more boxes __--~---------------Tl
to choose typestyles.

Click one box to choose spacing of type Iines.

l8J Ploln

o Bald

o Itafle

Spoelno

D~

o 11.1.
o

RIIQf"IIMnt

[ra:J

LETTERHEAD F le Edll Selectlons Grllphle Fonts FontSize

Untltled

letterhead
I8!Pla,n D~

RII"..nt.Spocinv

Click one box to choose type alignment­
lett, center, right.

Click one box to choose spacing of type lines.

Click to see top or bottom
letterhead panel. @ Top

OBoll""
Clickon/offoneormoreboxes ----+---- 0 Bald 0 ~II

to choose typestyles.

Click to choose a ready-made letterhead.

BANNER * File Edi! Seleetion Grllphles Fonts FontSize

Untltletl

Banner Window

l8J PIOln

o Bald

Move along serail bar to
see entire banner.

Your currently selected graphics-<:lrag
one or more graphics and place

in the Banner Window.

Click to see small or large graphics.

Click to edit pixel shape and pattern
of text message.

"".1,",'

Click to choose a ready-made banner.

...•.,..",,';":!! !

Q!::2p~

@Sololl

o larQ@
Danner

O~
OlllllolUl_

---,---0

Click on/off one or more boxes to
choose typestyles.

9



THE MENU BAR • File Edit Selections Graphits Fonts FontSize

You will go to the Main Menus to make selections that are common to all
Print Shop prajects-for example, to print, to choose your graphics, to
preview or see the whole project as you are designing it.

APPLEMENU I 11::. File Edit Seleetions &rtll)hle~ f,)ots l'lmtSlzt'
flbout The Pr!nt Shop ...

fllerm Cloek
Chooser
Control Penel
Key CliPS
SerllPbook

I

This menu contains several common desk accessories. You may find
these particularly helpful with The Print Shop program; use them the same
way you would in any other program.

Key Gaps Lets you see the letters and symbols of your fonts. Select this accessory
from the Apple Menu as you design your praject. A keyboard will appear on
screen, as weil as an extra menu at the far right of the Menu Bar-this is the
Key Gaps Menu.

fontSlzt' Key C p.. File EdU

Example: Cairo font

Dtt<1fiC

Spaci"9

Sign

o l.ind@.. , ! os

o 000 Dm

o
AI i9f1ll'.... t
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Select a font fram the Key Gaps Menu and the lower case letters/symbols
will appear on the keyboard. Press Gaps Lock or Option to see the capital
letters/symbols available in the font you have selected.

You can type a few letters and see how they look in the space above the
keyboard.

You can use Key Gaps to see the typestyle possibilities of any font. It is
especially useful for locating particular characters in a graphics font, such as
Gairo.



Scrapbook Lets you get text and graphics from other programs to be used in your
Print Shop projects. You can also use the Scrapbook to store Print Shop
graphics for use in other programs.

FILE MENU . Edit Selectlons Grophics fonts fontSize

New
Open...
Close
Rellert
SOlle
SOlle Rs ...
Preferences .
Select Colors .
Print Options .
Rdjust printer .
Print Slgn ...

Quit

New Lets you start a new project of the same kind you have been working on.
If you have finished a sign, and want to design a new sign, select New.
Note: 5electing New will erase your previous design; if you
want to save your design, be sure to do so before selecting
New.

Open Lets you open a saved project file of the same kind. For example, if you
are working on a banner, select Open to open one of the banner files saved
on your disko

Close Lets you close a project file. When you close a project file, the program
will return to the Project Selection screen.

Revert Lets you return to the last saved version of the project.

Save Lets you save your design to an already named file. Note: Although
you can save your designs to The Print Shop disks, we
recommend that you save them to your own data disks.

Save As... Lets you set up and name a new file to save your design.

Preferences Lets you customize your loading procedure. See Section 8, Special
Features, for details.

Select Colors Lets you select colors for each of your design elements before printing
with a color printer.

Print Options Lets you choose special layout features for greeting cards and banners.

Adjust Printer Lets you test to make sure your paper is properly aligned so that your
projects will print out correctly.
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Print... Lets you print your project.

Quit Lets you leave The Print Shop. If you've made changes in the current
project, you'lI be given an opportunity to save the changes before quitting.

EDITMENU Selections Grllphics Fonts FontSize

Uodo :)('2

Cut IlliH
Copy IlliC
PlIste IlliU
Clellr
Select All A

Show Clipbollrd

Undo Lets you undo your most recent typing. Use Undo for such things as
restoring text that has been deleted by mistake or cancelling your last
keystroke.

Cut Lets you remove the current selectio~sually highlighted text-and
place it on the Clipboard.

Copy Lets you copy the current selection to the Clipboard.

Paste Lets you add the contents of the Clipboard to your document at the
cursor. You can also use Paste to replace text on the screen with text in the
Clipboard. Highlight the text on the screen that you wish to replace betore
selecting Paste.

Clear Lets you c1ear the current selection. When you c1ear, the selection will
not be placed on the Clipboard.

Select All Lets you select or highlight the entire text of your sign, greeting card or
ietterhead panel. This enables you to quickly cut, copy, etc. the entire block
of text.

Show Clipboard Shows the current contents of the Clipboard.

SELECTIONS MENU '* File Edit Grophlcs Fonts FontSize

12

'/Sign
Bonner
lelterheod
Greetlng Cord

PreLJiew...

You can go to this menu whenever you want to switch fram one kind of
project to another. If you have been working on a sign, tor example, and want
to switch to a greeting card, simply click Greeting Card.



Preview This feature lets you preview your full design-text, borders and
graphics-before you print it. Select Preview to see the full page of your
letterhead or sign, the front and inside of your greeting card, or your
complete banner.You can see how your design looks any time you want.
Select Preview before you add new elements-Iarge graphics, new borders,
etc. Select Preview before you print your project to make sure you are
satisfied with your completed design.

GRAPHICS MENU • File Edit Selectlons Fonts FontSfze
Select Grll-p':"'lJ:'""ic-s.-..----=G:"T'"----...

To-From Mllcplllnt'M file... :lCM
To-From Clipbollrd...

1---------------
GrllplJic Lllyout... :lCl
GrllplJic Editor... :lCE

Sllue 6rllphlcs... :lCS
DeieIe Grllphics... :lC0

You will use this menu whenever you want to select, modify or layout
graphics in your project. You'lI find a full explanation 01 the Graphics Menu in
Section 3 of this manual.

FONTS AND FONTSIZE I • FIle Edit Selectlons 6rlloIJics Font... Font\ILP
-"Ithens

Celro
Chicego
Courier
Geneue
Heluetlce
London
Los Rngeles
Moneco

ew York
Sen Frenclsco
Seettle
Tlmes
Toronto
Uenice

9 point
10
12
14

./flID
20
24
30
m
48
72

These menus show the different fonts and type sizes you can use in your
projects. Select a font from the Fonts Menu. Then open the FontSize Menu
and choose the size you wish. The recommended sizes for the type you've
chosen appear in outlined numerals.
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3. THE GRAPHICS MENU

Whatever Print Shop projeet you deeide to make, you will probably want
to use graphies. You may want to add a birthday eake to your greeting eard, or
one of your own MaePaint drawings to your banner, or a digitized photo to
give your letterhead a special touch.

The Print Shop allows you a great deal of freedom and ereativity in
seleeting, editing, and laying out graphies. You ean make seleetions for all of
your projeets quiekly and easily by using the Graphies Menu.

The items in the Graphies Menu work in the same way for all of the
different Print Shop projeets: Greeting Cards, Signs, Letterhead, and
Banners.

fonts fontSlze
Select 6rllptllcs... :M:6
To-from Mllcplllnt'M nie... :M:M
To-from Clipbollrd ..•
----------1

6rllptllc Loyout...
6rllptlic Editor...

SlIue 6rllptlics...
Delete 6rllptlics...

14

Seleet Graphics

To-From MaePaint File

To-From Clipboard

Graphie Layout

Graphie Editor

Save Graphies

Delete Graphies

Lets you pick a seleetion of smalI, large, and full panel graphies from The
Print Shop Graphics eolleetion or other graphies library files to use in your
projeet.

Lets you seleet graphies from any MaePaint file to use in your projeet.

Lets you seleet graphies from the Clipboard for use in your design.

Lets you layout your graphies on the projeet you are designing.

Lets you modify small and large graphies before you use them in your
design.

Lets you save one of the eurrently seleeted graphies to a graphics library
file. It also lets you save agraphie you have modified with the Graphie Editor tl
a file or lets you reorganize graphies into a different file.

Lets you delete agraphie fram a graphies library file.

You ean use these options at any time and in any order you want, but
you'lI probably find it easiest to seleet your graphies first, either from Seleet
Graphies or from a MaePaint file. Then you ean use Graphie Layout to add thl
graphie to your design or Graphie Editor to make ehanges before you plaee
the graphie in your design.

Save Graphics and Delete Graphies are features you will want to use to
ereate and revise your own personal graphies library files.



Os.oall
@Large

OFull Panel

I Change fll.1

fonts fontSize• file Edit

Active Selection Box _--ftt--""~

SCroll Bar

SELECT GRAPHICS

Your Currently Selected Graphics

The Print Shop Graphies eolleetion has three different types of pietures
you ean uSEr-small, large, and full panel graphies. Cliek the button next to the
size graphies you wish to see.You ean ehoose 41arge and 4 small graphies to
use in designing your eurrent projeet. You ean also ehoose full panel
illustrations for all projeets exeept Banner.

The eurrently seleeted graphies appear at the top right. A dotted
reetangular box surrounds one of them. This is the Aetive Seleetion Box. To
select a new graphie to replaee the one in the box, seroll through the graphies
in the large window. Cliek the one you want. The graphie you eliek will replace
the graphie inside the Active Selection Box. To replaee another ofthe
currently selected graphies, first eliek the graphie you want to replaee. The
graphie you dick will be surrounded by the dotted box. Now, seleet a new
graphie fram the large window just as before. You can replace any or all of
your eurrently seleeted graphics in this way.

Remember to move the dotted box to the graphie you wish to replaee
before selecting a new graphie.

Large, SmalI, Full Panel It's easy to piek all your graphics-small, large, and full panel-at one time.
All you have to do when you are finished making selections of one size is click
another size. The Print Shop graphics available in that size will appear in the
large window. You can then change any or all of the currently seleeted
graphies that appear at the top right.

Full Panel Placement Full panel graphies are available for greeting cards, signs, and letterhead.

When selecting full panel graphics for greeting cards, you can pick a
panel for both the front and the inside of your card.

• Click Front or Inside to indicate your choice.

When selecting full panel graphics for letterhead, you can pick a panel for
both the top and bottom ofthe page.

• Click Top or Bottom to indicate your choice.
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Full Panel Graphie Seleetion Window tor Greeting Card & Sign:

• File Edlt Selections Fonts FontSize

@Fr-onl

o Inside

Os.all

OLarge

@Full Panel

I CI>onge (ile I

Full Panel Graphie Seleetion Window tor Letterhead:

• File Edlt Selections Fonts FontSlze

@Top

o 8ollOIl

Os.all

OLarQOl

@Full Panel

I Chong! file I
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Finished Seleeting Graphies? Onee you are satisfied with all your graphie seleetions, c1iek"="",=,,,
to return to the Main Projeet sereen and eontinue with your projeet.

Changing Graphie Files To get graphies from the Print Shop Graphies file or from a graphies Iibrary
file you have ereated (see a e 24 for instruetions on how to save and
delete graphies), eliek Change fll e . A dialog box will appear allowing you to
ejeet disks, seleet drive, insert a new disk eontaining graphics files, and open
a file. Your file will appear on sereen and you ean make seleetions from it.

TO-FROM MACPAINT FILE Seleet To-From Maepaint file to eopy graphics from any of your MaePaint
files to your smalI, large, and full panel graphies or to eopy Print Shop graphies
to MaePaint files.

When a dialog box appears, you ean ejeet a disk, insert another disk
eontaining graphies files, and open a file.



• file Edlt Selections • I Fonts FontSize

Moepalntftl fi I.

(rC:C-1_-ar'I I Load I '[-=-5o-u-• ...,

I <-CopY<-1 [->copY-' I
o SIlO I I @ Lorg_

o Full panel

Seroll Bars ---t-;::;::~~~~~1T1------:------""'~

Capture Box ----If--+=:4."""'*-+fJ~+--+--

MaePaint File Window

Aetive Seleetion

Your Currently Selected Graphies-either
smalI, large, or tull panel

After opening a new MaePaint file, use the seroll bars to move around in
the MaePaint file window.

• Cliek SmalI, Large or Full panel to ehoose the size of the graphies you
wish to add to or replaee. Choose the size depending on the size of the
MaePaint graphie you wish to eopy. Note that the size of the dotted eapture
box in the large window ehanges as you switeh fram small to large to full panel
graphies.

One of your graphics will appear in the Aetive Seleetion Box. This graphie
will be replaeed with any you seleet fram your MaePaint file. If you wish to
replaee another graphie, eliek on it. It will then appear in the Aetive Seleetion
Box.

COPYING FROM MACPAINT Drag the eapture box to the part of the MaePaint file you want to eopy.

• File Edit Selections

[ <-cOpY<- I [->copv-> I
o Sea 11 @ Large

OFul1 panel

( Reverl I

Fonts Fontsize

Cliek[ '-COPY<- I. The graphie inside the eapture box will replaee the one in
the Aetive Seleetion Box.
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You can keep modifying this image by moving the rectangle and copying
the new image.

Centering the Image You can center or move the copied image in the Active Selection Box,
too. Move the pointer inside the box. The pointer becomes a Grabber hand
that allows you to drag the image around inside the box.

Touching Up Your Image You may wish to erase part of the surrounding MacPaint file so you can
copy a clean image. If you press the Option key, the Grabber in the MacPaint
window will become an eraser that you can use to erase any part of the image
that you want. You can also erase in the Active Selection Box by moving your
pointer into the box and then pressing the Option key.

Changing the Capture Box You can change the size of the capture box in order to copy a larger or
smaller portion of an image. To do this:

1. Click outside the capture box.

. 2. Position the cross hair (+ ) at the upper right corner of the image you
wish to select.

3. Drag until the box captures the portion of the image you want. Then
release the mouse button.

4. Click I<-Copy<-l.

Note: If you want to clear the captured portion of the image, press
Backspace; everything within the capture box will be c1eared.

You may wantto experimentwith different sized or shaped capture boxes
to get an image you Iike. If the proportions of your capture box are very
different from the size of the original, your image may be somewhat distorted.
You can use this distortion to create various effects.

Remember to Revert The Revert button can be a lifesaver! Click it to restore your active
selection to its original form. If you've made changes you don't like, choose
lReverll.



Continue Making Seleetions When you are satisfied with the graphie in the Aetive Seleetion Box, you
ean eontinue adding graphies trom your MaePaint file.

• Cliek another graphie. It will appear in the Aetive Seleetion Box. You ean
then replaee it with a graphie tram the MaePaint file in the large window.

• Cliek~ to view another MaePaint file.

• Cliek when you are ready to save the ehanges you've made
and eontinue with your design.

COPYING Ta A MACPAINT FILE You ean eopy to a MaePaint file as weil as eopying trom one. This is a
handy feature. It allows you to save graphies from The Print Shop to a
MaePaint file.

You might want to do this if:

1. You want to edit a graphie in MaePaint rather than in the Graphie Editor.
Note: This is the only way to edit full panel graphics.

2. You've ehanged agraphie and you'd like to keep it in a MaePaint file for
further use.

To eopy the aetive seleetion to the MaePaint file window, cliek [->CoPI/-> l.

To save your ehanges in the large window as a new file, eliek~ and
follow the direetions in the dialog box.

You ean save the graphie in the same size or modify it by stretehing or
shrinking the capture box in the MaePaint file window.

The Copy Keys If you should press the wrong Copy key, here's what you ean do:

If you press [->Copy-> 1by mistake:

1. Cliek~.

2. Cliek No when the dialog box appears. Da NOT save the MaePaint file.

3. Reload your MaePaint file. No ehanges will have been made.

If you press [<-Copy<-) by mistake:

1. Cliek I ReYerl I. Your original graphie will appear in the AetiveSeleetion
Box. You ean then eontinue making seleetions fram your MaePaint file, if you
wish.

TO-FROM CLIPBOARD Seleet To-From Clipboard to eopy any of the eurrently seleeted graphies
to the Clipboard or to eopy the eontents of the Clipboard to any of the
eurrently seleeted graphies. Use To-From Clipboard exaetly as you would To­
From MaePaint files.

Note: Text ean be treated as agraphie, using the praeedures for
eonverting text to graphics outlined in Seetion 8, Special Features.
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Finished Seleeting Graphies? Onee you've seleeted your graphies, you can either seleet the Graphie
Editor to modify your graphies or go direetly to Graphie Layout to position
your graphies in your projeet.

GRAPHie LAYOUT Seleet Graphie Layout when you are ready to plaee your seleeted
graphies in your design for eards, signs, and letterhead. You will then see the
Graphie Layout sereen. If you are making a banner, you will add your graphies
on the Main Banner sereen.

Projecl Panel ---1+-+---

GREETING CARDS & SIGNS

Active SeleClion Window

Currently Selected Graphics

• file Ed t Selections

@Fronl Olnsldol DFul1 panel 05.011

@Lar'Q8

Greeting ClIrd ~I Sl"l!98 .-:t I
§nllh!.k...L.ll.y.l!.!!.! ~I Unda 11 cancel I OK
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Getting Started The layout sereen for Greeting Card and Sign is the same, exeept that for
a greeting eard you ean ehoose a graphie layout for both the inside and the
outside. If you are designing a greeting eard, seleet whieh panel-front or
inside---you wish to work on first.

Then ehoose whieh size graphies you want to work with first. Cliek Small
or Large. Three of your seleeted graphies appear on the right.

One of the graphies appears in the Aetive Seleetion Window. It appears in
several sizes. You have a ehoiee of five different sizes for small graphies and
two for large graphies.

The panel on whieh you will layout your graphies appears at the left of the
sereen.

Positioning Your Graphies Move your pointer to one of the different sized graphies in the Aetive
Seleetion Window. Press the mouse button and a Grabber hand will appear.
Drag the graphie to the panel and position it where you want.

You can move your graphie within the panel by dragging. You ean also
drag more graphies-the same size, larger, or smaller-from the Aetive
Seleetion Window to plaee in your design.

To remove agraphie from your eard, simply drag it off the panel.

Want to add a different graphie? • Cliek another graphie. It will appear, in different sizes, in the Aetive
Seleetion Window. You ean then drag the graphie you want onto the panel.



Want to add a Full Panel? • Cliek Full panel to see the full panel graphie you have seleeted
displayed on your prajeet. Ta remave the graphie. eliek again to "turn off" Full
panel.

Switehing Sizes and Panels • Cliek Small/Large to switeh fram one size set of graphies to another.

• Cliek Front/Inside to switeh from one greeting eard panel to another.

Note: Usually, you will seleet the smalI, large. and full panel graphies you
want to use in your projeet before you start to da your layout. But sometimes
you may get an inspiration while working on the layout and want to select
same different graphies from a MaePaint or graphies library file.

You ean da this but you should remember that the ehanges may affeet
your present layout. If you have begun your layout and added a heart, for
example. and if you then replace the heart with agraphie of a fish, the fish will
appear on your layout in plaee of the heart.

If you want to seleet new graphies after you've begun laying out your
design, try to replaee ones you have not al ready used.

Same Special Effeets If you want a repeated pattern of images, seleet ~ or [ S\agger-ed I.

• Cliek~ to see images repeated aeross and down the page.

• Cliek I S\C>!l\lered I to see staggered images.

• Cliek either button again and again to see all the different variations
possible using your eurrently seleeted graphies.

• Cliek~ to quiekly c1ear your panel of images. Then you ean begin
your layout again.

• Cliek [ Undo I to eaneel your last action.

• Cliek [Cancei I to return to the Main Projeet sereen without saving your
graphies layout.

• Cliek n OK D when you are satisfied with your layout.

LETTERHEAD • rile Edit Selections ronts rontSlze

~" @
Tlled OFul1 pan.1 (5 \agger-edI

[!]~
0511\011 @Lorge

Ti led o Full panel 15\oggered]

@

[ CI_ar Undo

( Cancel I t OK ~
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To add the eurrently seleeted graphies to your letterhead, simply drag
your graphics and plaee them on the top or bottom 01 your page. You have a
ehoiee of two different sizes for small graphies and one size for large graphies.

• Cliek OI!:!D, ( Staggered J, or Full panel at the top or the bottom to add
special graphies effeets.

• Cliek the Design Une buttons on/off. You ean either retain or erase one
or both of these two lines that delineate the top and bottom of the letterhead
areas. If you do not want a design line to be printed, make sure that the
button to the right of the line is turned off.

• Cliek~ to erase your graphie layout so you ean begin again.

• Cliek I Cancei ] to return to the Main Projeet sereen without saving your
graphies layout.

• Cliek I Unda I to eaneel your last aetion

• Cliek ~~;;// when you are satisfied with your layout.

fonts fontSize

QmphiC Editor

o Sotall @Large

• file Edit

Pattern Scroll Bar ---ln~~

Aetive Seleetion Box

--[

~ (cl.er 11lk>da ]
Graphie Editor Buttons ~ (Revert] [eancOI] b=-r--.---=~~--"~----r.>d"'-I

IPa.lell5av.I~

Editing Tools Scroll Bar ---H-KJI

GRAPHie EDITOR

Editing Window Currently Seleeted Graphies ----J

Editing SmalVLarge Graphies You may edit any of your small or large graphies by seleeting Graphie
Editor from the Graphies Menu.

Cliek Small or Large to ehoose whieh size group of graphies you wish to
edit. Three 01 your eurrently seleeted graphies appear at the right. One
appears in the Aetive Seleetion Box on the left and also in the Editing
Window. To ehoose another graphie to edit, simply cliek the graphie you want.

Small graphies will appear in full in the Editing Window. Large graphies will
appear in part. To edit a different part of a large graphie, use the seroll bar to
move the graphie in the Editing Window, or seleet the hand ieon from the
editing tools. Use the hand to move the graphie around in the Editing
Window.
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Note: If you wish to edit a full panel graphie, you ean do so by moving the
graphie into a MaePaint file and using MaePaint. See page 19 for details on
Copying to MaePaint.



Flipping Your Graphie • Press l!:J and H to f1ip your graphie horizontally.

• Press l!:J and V to flip your graphie vertieally.

• Press l!:J and I to invert your graphie from blaek to white. Press again
to revert baek.

Seleet Tools/Patterns You may seleet tools to use in editing your graphies and patterns for
painting or filling in areas.

The eurrently seleeted tool and pattern is surrounded by a small box.

• T0 seleet another tool or pattern, cliek it. The box will appear around
your new seleetion.

• Cliek on the left and right arrows to seroll through the bars and see all
your tool and pattern ehoiees.

<) 0 [l] g Q

<) ::::••Q
Pattern

After seleeting a tool, move your pointer into the Editing Window and
press the mouse button to aetivate the tool.

Your Editing Tools ~ Lets you grab and move the graphie around so you ean edit all parts
of it.

~ Lets you draw a thin line-blaek on white or white on blaek.

g Lets you erase parts of your graphie.

~ Lets you fill an outlined area with the eurrent pattern. (If an outline
has gaps or holes in it, the paint "Ieaks" through. Choose Undo from the Edit
Menu. Then fill in any holes in the outline.)

.r!J Different-sized paint brushes let you paint with the eurrently seleeted
pattern.

Note: All the editing tools, exeept the~ ,will work the same in both the
Aetive Seleetion Box and the Editing Window.

The~ moves the graphie around in the Editing Window. It also moves
the graphie in the Aetive Seleetion Box. However, any part of the graphie you
move outside the box will be eropped as soon as you release the mouse
button. By eropping a graphie in this way you ean ereate a different image. If
you erop your graphie by mistake, seleet Undo to eaneel your last aetion or
Revert to restore the original graphie.
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Graphie Editor Button As you edit the graphie in the Editing Window, your ehanges are
displayed in the Aetive Seleetion Box.

Before making a major change, you may want to make a eopy of the
graphie for your Clipboard. This will save the graphie in the Aetive Selection
Box as is so you ean keep it and paste it back later if you wish.

• Cliek~ to remove the graphie fram the Aetive Seleetion Box and
Editing Window and plaee it on the Clipboard.

• Cliek~ to add the graphie in the Aetive Seleetion Box to the
Clipboard.

• Cliekl Past.) to paste the contents of the Clipboard into the Aetive
Seleetion Box and Editing Window.

• Clieklc1e<>r' I when you wantto c1earthe Editing Window. This will also
c1ear the Aetive Seleetion Box.

• CliekIR.......tl if you wish to restore your aetive seleetion to its original
form. The Revert button insures that you will never lose the original graphie
you had when you entered the Graphie Editor.

• Cliekl So"" I if you wish to save your edited graphie to one of your own
graphies library disks. The Save Graphies sereen will appear and you ean
make a new file or seleet a file in whieh to save your graphie. Cliek the graphie
and it will be added to your file.

• Cliek (Unda I to undo your last action.

• Cliek lCanc.11 to return to the Main Projeet sereen without reeording any
of your ehanges.

• Cliek~ when you are satisfied with your editing.

Using The Clipboard You ean use the Clipboard in a variety of ways to move graphies to and
from the Serapbook. See Seetion 8, Special Features, for a detailed
explanation of some other uses of the Clipboard.
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Using Save Graphies You ean ereate your own graphies library files by using the Save Graphics
funetion. You may want to make a file of your favorite graphics or to eombine
graphies from different disks in a new file. You ean even make speeial subjeet
files to suit your personal needs.

• Seleet Save Graphies to start a new file or add to an old one.

• Cliek I New file) to set up a new file. A dialog box will appear, allowing
you to make your seleetions.

• Cliek I Ch0rlge fi le I when you want to add agraphie to an existing file.
The eurrently seleeted graphies appear at the left. You ean save any of the 4
smalI, 4large, or full panel graphies by elieking on it.

DELETE GRAPHICS To delete graphies from the files you ereate, open Delete Graphies.
Seleet the file from whieh you wish to delete agraphie and the size graphie
you wish to delete.

Serail though the library of graphies and eliek any unwanted ones. The
graphies you eliek will move to the trash ean on the sereen.

Note: You eannot eaneel a Delete Graphies eommand. Onee graphies
are deleted, they cannot be restored. Therefore, be eareful to seleet only
those graphies you really want to delete.

The Print Shop Graphies Colleetion You ean save and delete graphies to and from any new Iibrary file you
ereate. But you eannot save or delete graphies to or from The Print Shop
Graphies eolleetion. If you try to add or delete graphies to or fram that file, a
dialog box will appear instrueting you to seleet another graphie file. This
preserves the original graphie library and prevents deleting any of the original
graphies by mistake.
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GREETING CARD and SIGN

With The Print Shop, you'lI be able to ereate the perfeet eard to send for
any oeeasion and make a sign everyone is sure to notiee. Signs and Greeting
Cards are designed in mueh the same way. The only differenee is that to
make a Greeting Card you design two panels-front and inside. To make a
Sign, you design just one. With both Greeting Cards and Signs, you ean
ehoose from a wide variety of graphies, borders, and fonts, as weil as edit or
ereate your own graphies, or seleet ready-made projeets for quick results.

Congratulations

(jracfuate!

To make a Greeting Card, click on the Greeting Card icon on the Project
Selections screen or open Greeting Card from the Seleetions Menu. The
Main Greeting Card screen will appear. You can now decide if you wish to
make a ready-made eard or to ereate your own design.

READY-MADE The Print Shop's ready-made projects are designed to give you as much
freedom as you want. You ean pick a eard and print it without making any
changes. Or you can seleet a ready-made eard and use it as a base for
designing your own card. You ean start with a ready-made card and add text,
change borders, seleet different graphies, ete. The ehoiee of what ehanges
to make is yours.

• Cliekl Read'rmade I to seleet one ofthe ready-made cards in the program.

A dialog box appears and you can select one of the ready-made eard files
on your Print Shop Graphies disko If you seleet Birthday, for example, the front
and inside panels of a birthday card will appear.

• Cliek Choose to seleet another eard from the Iisting.

• Cliek if you wish to seleet the ready-made eard on the sereen. If
you want to print your card now, turn to Section 7 for details on printing. If you
want to change the ready-made design, read on to see how you can ereate
your own designs.

• Cliek I Cclncel I if you want to return to the Main Greeting Card sereen
without making a ready-made seleetion. Note: 11 you select ( Ready-Ilade I
while you are in the midst of designing a greeting card and
then change your mind and seleet (Cane.1 I, you will be returned to the
projeet you were worklng on, rather than to the Main Greeting
Card screen. To return to the Main Greeting Card screen, in
this case, seleet QI(



DESIGN YOUR OWN You don't need to start with a ready-made eard. You ean design your own
eard entirely from serateh.

You ean pick borders, seleet graphies, ehoose different typefaees,
eompose your own messages, and personalize your eard in just about any
way you want.

Beeause the program is so flexible, you ean begin wherever you wish.
You may find that you begin by ehoosing a border first for one eard and a
graphie first for another.

Generally, it's best to begin by ehoosing the most important or
predominant element. For example, if you want an elaborate border on the
front of your eard, pick the border first and then type in your message. If the
message is more important, you may want to ehoose a font first.

It is, however, a good idea to seleet and edit your graphies before you
begin laying out your design.

--------------
FRONT/INSIDE You ean design two panels for your eard-a front and an inside panel. To

work on a panel, cliek the appropriate button. These buttons will appear
throughout the Greeting Card program. By using them, you will be able to
switeh easily from one panel to the other, so that you ean eoordinate the
borders, graphies, and fonts that you use.

The Seroll Bar Most of the greeting eard panel you are designing ean be seen in the
window. However, a small portion is hidden from view. To see the entire
panel, use the seroll bar.

BORDERS Cliek I Bo,..del"'S I to change the border on your front or inside panel.

• Filll Edit Slllllctions Gnlphics Fonts FontSizll

BDrJr:
rBorder Window ---it-it~~r

Aclive Selection Box

You will see the border eurrently seleeted for your panel in the Aetive
Seleetion Box.

Use the seroll bar at the bottom of the Border Window to seroll through
the entire border eolleetion.

Seleet a border by elieking on it. Your new ehoiee will appear in the Aetive
Seleetion Box.

Cliekl Cone.. 1 I to return to your original border seleetion.

When you are pleased with your border seleetion(s), eliek '--~~
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TEXT You can type a message for your Greeting Card and decide how you want
it to appear. You can choose a font, a typestyle, line spacing and alignment of
text. Once your message is typed, you can change any part of your text
quickly and easily.

Making Font and Typestyle • Open the Font Menu. Acheck appears next to the currently selected
Selections font. You can change the font by clicking another.

• Open the FontSize Menu. The menu lists different available point-sizes
for the currently selected font. Because some fonts look better in certain
sizes than others, recommended sizes for a chosen font are outlined.
Selecting one of the outlined sizes will give you the best results.

Click the boxes on the Greeting Card screen to:

• Select the style of your type-bold, underline, etc.

• Select the spacing between lines.

• Select the alignment of the text-Ieft, center or right.

Typing Your Message A flashing cursor appears on the top of your card. The cursor marks the
spot where you can type your message. You can move the cursor by
pressing Return or Backspace or by selecting a different type alignment from
the boxes on your screen.

• To start a new line, press Return.

• To move up a line, press Backspace.

• To erase, move the cursorto the right of the letter or word to be erased
and press Backspace. Or, if you prefer, highlight the text to be erased and
press Backspace. (To highlight, position your cursor to the left of ihe first
word to be erased. Drag the cursor across the text; the text will appear
highlighted in black. Highlight all the text you want to erase and release the
mouse button. Then press Backspace.)

• To undo your lasttyping action, select Undo from the Edit Menu before
doing anything else.

Changing Font and Typestyle You may need to try different fonts and typestyles to getjust the right
look for your card. You mayaiso want to use several different fonts and styles
within the same message. Changing yourtype selections is easy.

• To change the font or style of the next ward you type, simply make your
type selections and then continue typing.

• To change the font ortypestyle of a previously typed word or phrase,
highlight the word or words you want to change. When all the text you want to
change is highlighted, release the mouse button. Now make your type
choices. When you are satisfied, dick to remove the highlight.

Note: If you make amistake and erase any or all of your text,
go the the Edit Menu and select Undo before doing anything
else. Your erased text will reappear.



GRAPHICS You can add graphies to your eard using the Graphies Menu. For
instruetions on how to use the Graphics Menu, see Seetion 3. By reading this
seetion you wililearn about all of The Print Shop's graphie possibilities. You
will find out how you ean select graphies from various graphics files, ineluding
your own MaePaint files, and how you can edit your graphies and lay them out
on your project.

Note that when you add graphies to your layout, you do not have to worry
about eovering up your text. Any text that overlaps a graphie will be "masked"
so the type will still be readable.

Note: Sometimes when you are adding type to the Main Projeet sereen
Ir 9,aphies in Graphie Layout, you may want to remove your border. Pressing
ll€ and N will remove the eurrent border on the panel you are designing.

PREVIEWING

Front

Greeting (erd Preuiew

Inside

After you've ehosen the various elements-borders, type and
graphies-you ean preview your whole eard. Seleet Preview from the
Selections Menu to see the front and inside panels you've designed. lf
something doesn't please you, you ean go baek and make whatever ehanges
you wish.

A Credit Une ForYour Cards Add a personal toueh with your own eredit line. Cliek Creditto type in a
one line credit (Made by me and my Macintosh, for example) that will appear
on the baek of your eard.

SAVING Whenever you want to save your projeet to a file, select Save As... fram
the File Menu. A dialog box will appear. You ean then insert a data disk, name
your praject, and save it. It is reeommended that you save your files to a
separate data disk and not to either of the Print Shop disks. Once a project
has been saved, it will appear on the desktop with an appropriate prajeet file
icon.

Select Save whenever you want to save design ehanges to your project
file.
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PRINTING When you're ready to print your card, turn to Section 7, Printing Your
Praject, for full details.

Note that checking your paper alignment is very important when making a
Greeting Card. If the paper is not positioned properly, your card will not be
correctly centered on the page when you fold it. Select Adjust Printer from
the File Menu to check your paper alignment. The printing test will print four
corners. Adjust your paper position and repeat the test until the corners
appear correctly centered.

When your entire card is printed (half upside down, half right-side up in
alternate corners), remove it fram the printer and fold it in quarters. Your
finished card will have your design on the front and the inside, and an
optional credit line on the back.

Note: Special layout features are available for Greeting Card. For more
information, see Section 8, Special Features.

Ready To Start Again? To design a new card, select New from the File Menu.

To design a different project, select Banner, Sign, or Letterhead from the
Selections Menu.

MAKING SIGNS Making a sign is like making one large panel of a greeting card. Your sign
will print on one full side of an 81/2 x11 inch sheet of paper. Your borders, text
and graphics will appear larger than on the smaller greeting card panels.

You select borders, graphics, and type styles for your sign the same way
you select them for a greeting card.

o lJnder: I i ne

o IIlMlQII
o

Spacing

181 Plaln

o Bald

o !tafle

I Borders I I f!eady-llOde I

1234 MAG OLIA LN.
WESTBAA, CA 95957

• File Edit elections Grllphics Fonts

Untitled
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5. LETTERHEAD

With The Print Shop you ean design your own stationery and letterhead.
You ean ehoose a ready-made design and either print it as is or use it as a
template, ehanging it in any way you want. Or you ean start fram serateh and
ereate your own unique design. You'lI find it easy to make stylish letterhead
for all your business needs, as weil as personal stationery that refleets your
interests and personality.

Your letterhead ean have pietures andlor text at the top, the bottom or
both areas of the page.

GLOBAL TRAUEl

~ [ale [l'eationl

Imfld""."
....... u.Gi1W7

CI01JIß.1IIII!i

READY-MADE If you'd like to ehoose a ready-made design, diekl Reody-1IOde I. You ean then
seleet, fram a dialog box, a number of different ready-made letterhead
designs. Open the design you wish to see.
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• Click Choose if you want to return to the dialog box listing, and select a
different letterhead design.

• Click ~ OK D if you want to select the ready-made design on the
screen. If you wish, you can print your letterhead without making any
changes. (See Section 7 for printing details.) Or, you can add whatever
elements you wish: your name, address, slogan, new graphics, etc., before
you print.

DESIGN YOUR OWN

TEXT If you want to work on your text message first, select the area - top or
bottom - in which you want your text to appear.

Position your cursor at the place you want to start yourtext. You can
position the cursor either by clicking one of the alignment boxes -Ieft,
center, right - or by using the keyboard.

To move the cursor down a line, press Return. To move up, press
Backspace. To move right on the same line, press the spaoe bar. To move left
on the same line, press Backspace.

Then select your typeface and size from the Fonts and FontSize Menus.
Select your typestyle by clicking the typestyle boxes on the screen.

Once you've made your text selections, you are ready to type your name,
address, orwhatever message you wish. To start a new line, press Return.
Press Backspace to delete.

Changing Font or Style You may want to change your type selection or use a combination of
selections in the same letterhead. Changing your type selections is easy. To
change the font or style of the next word you type, simply make your
selections and then continue typing.

T0 change the font or typestyle of a previously typed word or phrase,
highlight the word or words you want to change. Make your new type
selections; then click your mouse to remove the highlight.

Note: If you make amistake and erase any or all of your text,
go to the Edit Menu immediately and select Undo.

For a complete discussion of creating and editing text with the Macintosh,
see pageS.

When you've finished designing the text for one part of your letterhead,
select Top or Bottom to design text for the other part.

GRAPHICS You may select and layout your graphics at any time while designing your
letterhead.

You can select graphics fram The Print Shop Graphics collection, or from
any MacPaint file, and edit them by making selections fram the Graphics
Menu. See Section 3 on the Graphics Menu for detailed instructions.



When designing a letterhead you may ehoase 4 large and 4 small
graphies. In addition, you may seleet two horizontal full panel graphies­
one for the top, and one for the bottom of your letterhead. Onee you have
chosen andlor edited your graphies, seleet Graphie Layout from the Graphies
Menu.

Fonts FontSize

1;::::==:::::;------:;::::;-----;:=::::::::::;1@ '---.... '---
TII-.l 0 Full panel [5 laggered!

• File Edit Selections

Top Design Area

Design Lines

GRAPHIC LAYOUT SCREEN

Os.oll @LCll"9"

Boltorn Design Area -----#--+-

This area rernains ernply TII-.l OFul1 panel ISlagg.~.dl

~=~--+-::::.:...:.:..:....::=-~==~@
[CI""", ~

I Ca""" I I

Full panel-Ciick on/off Your Currently Selected Graphics ...J

Ta add agraphie to your design, simply drag any one of your eurrently
seleeted graphies to the top or bottom of you r letterhead. Ta remave a
graphie, drag it off your letterhead. You have a ehoiee of two different sizes
for small graphies and one size for large graphies.

You ean add as many graphies as you like. You ean even add agraphie
behind type.

Graphie Layout Sereen: Main Editing Sereen:
• file un Selec'ion,

.L
letterhead
o'~ I 0"··10" o~

GI"'. 0 ....11_

~ 0/,.,.",_

Full Panel Cliek the Full panel button next to the Top or Sottom Letterhead area to
either reveal or hide the panel you have seleeted for that area.

Design Lines Two lines appear on the sereen separating the top and bottom of the
Letterhead areas. If you want to erase one or both, simply eliek the button to
the right of the line. Cliek again to reaetivate the line.
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TilediStaggered If you would like to see a repeated pattern acrass the top or bottom panel,
c1ick~ or I Stagge,..d I. Keep c1icking to see various combinations until
you find one you like.

• rle [eil! s.e1~[t1.ft.

1 1 1 1
~ 0""'_'

• Clickl CI.er I to erase all graphics on the page.

• Clickl u.- I to undo your last action.

• Click I canc.1 I to return to the Main Letterhead screen without saving any
changes.

• Click""==--,,,when you are satisfied with your layout.

SAVING You can save your letterhead design at any time by choosing Save As...
from the File Menu. A dialog box will ask you to name your letterhead file and
insert a data disko Once your design is named and saved, you can continue to
work on it. As you complete different stages of your design, you can update
your file by selecting Save fram the File Menu. Your saved letterhead will
appear on the desktop with an appropriate praject file icon.

PREVIEWING You may want to preview your letterhead design before you print. To do
this select Preview from the Selections Menu. Check to see that you've
removed any preset messages from the top or bottom of your screen, and
any border lines that you do not wish to appear. If you want to make any
changes, return to the Main Letterhead screen or the Graphie Layout screen.

PRINTING If you are satisfied with your design and are ready to print, turn to Section
7, Printing Your Project.

Note: For information on how to copy your letterhead design to a
MacWrite document, see Section 8, Special Features.
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Ready to Start Again? To design a new letterhead after printing, select New from the File Menu.

To design a different project, choose Greeting Card, Sign, or Banner
fram the Selections Menu.



6. BANNER

Make a banner to wish a friend a great day.

l:Jfuppy ßirthday, Larry! I

Or one to eongratulate the whole team.

ICangratulatians, Chris, Ann, Susan, & Ja! I
Change the type to suit your whim. Choose different paint brushes for

different effeets.

'!ou+tt gtta t, tt
I You're great, Mate I

And add a few pietures to give a lift to someone's spirits.

Ger Weil SOO()!

READY-MADE

DESIGN YOUR OWN

GRAPHICS

Using The Print Shop, you ean make any day a banner one I

You can seleet a ready-made banner to print as is or to modify to suit your
own needs. Cliek I Reody-ooode I to see a listing of the available banners. Seleet
one from the dialog box. If you would like to see the listing again, Cliek
Choose. Cliek~ if you want to use the banner on the sereen.

If you want to print your banner as is, refer to Seetion 7, Printing Your
Projeet.

If you'd like to make ehanges in the ready-made banner, read on to see
how you ean add elements of your own.

You ereate your banner in the long narrow Banner Window.

As your banner gets longer, it will automatieally seroll to the left; not all of it
will appear at onee. Use the seroll bar to move fram one part of your banner to
another.

You ean add graphies to your banner from either the small or large size
graphies. Cliek either Small or Large to switeh sizes. Note: Small and
large size graphics will appear the same size when printed on
your banner.
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To add a graphic, simply drag one of the currently selected graphics to
the place where you want it to appear in the Banner Window. You can also
use the keyboard to add graphics. Simply type the keys which appear under
the graphic you want. The graphic will appear at the cursor location. This is
handy when you want graphics to appear in the middle of a message, or even
the middle of a word, you are typing. For a complete discussion of selecting
and editing graphics see Section 3, The Graphics Menu. Note: Text and
graphics are added on the Main Banner screen, rather than on a special
graphic layout screen.

-------------
TEXT The cursor marks the place where you can add text. If you want to add

text at a different place, simply move the cursor by using the mouse or
pressing the space bar.

Type the message you want on your banner. You can change the font,
fontsize and/or typestyles any time you want. All of the text on the banner will
be changed automatically to reflect your new choices.

Note: With banners you cannot use different fonts or styles
for different parts of your message as you can in other Print
Shop projects. When you make a font or typestyle change,
your entire text will change automatically.ltalic is not available
with banners.

Using The Pixel Editor Pixel Editor, a special feature available only in Banner, lets you change
the pattern and brush shape used in whatever typeface you select.

Since your banner messages are printed in large type, changing the
shape and pattern of the individual pixels that form the letters can change the
whole look of your message. You can soften the type with a pale pattern or
create a zany look with a different pixel shape. Experiment with this feature to
create your own unique effects.

Note: Pixel Editor is best used with typefaces that are no
more than 36 point in size. If you select a larger face, the pixels
will have to be halved. This generally reduces the legibility of
the pixel shape. If you want a larger sized type, you may prefer
to use the preset pixel brush shape.

• File Edit Seleclions Grophics Fant Fontslze

BQnnerTeHtO~

Sarnple Letter with Current Shape and Pattern

Brush Shapes

Current Pattern

8rush Patterns

I!D~WlraJ
~ .:.: Em~~

( Ccr-:.I ) (~]
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Seleet a new brush shape by c1ieking one of the brush shapes. The
newly chosen shape will appear in the Brush Shape Box.

Seleet a new pattern by c1ieking one of the brush patterns. This pattern
will beeome the Current Pattern and will be surrounded by a moving dotted
line. The sampie letter will change showing your new ehoiees.

• Cliek I Cone.1 I to eaneel all ehoiees and return to the Main Banner sereen.

• Cliek'l:l;;;;;;.......011 when you are satisfied with your ehoiees.

PREVIEWING Your banner ean be very short or very long; the size is up to you. To
preview your entire banner before or after finishing, seleet Preview from the
Seleetions Menu.

• File [dlt Grflphics Fonts FontSize

Bflnner Preuiew

Not satisfied with your Banner?

I"" " "Wt tntgf.) 110\1 a ~t'11 <tbt't.sUMS'

" ~n~ a ]f.lapP11 JIlttn ~tat' """"I

Press Baekspaee to delete letters and graphics one by one to the left
of the cursor. Or drag an unwanted graphie fram the Banner Window to
remove it.

To c1ear text and graphies from the entire banner, seleet Clear from
the Edit Menu. To start fram serateh, seleet New from the File Menu.

SAVING To save your banner, seleet Save As... from the File Menu. A dialog box
will appear. You ean then insert a data disk, name your banner, and save it.
Once your banner is named and saved you can eontinue to work on it.

Seleet Save whenever you want to save design ehanges to your banner.
Your saved banner file will appear on the desktop with an apprapriate projeet
file ieon.

PRINTING When you're ready to print your banner, turn to Seetion 7, Printing Your
Projeet, for full details.

Ready To Start Again? To design a new banner, seleet New from the File Menu.

To design a different projeet, seleet Greeting Card, Sign or Letterhead
from the Seleetions Menu.
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7. PRINTING YOUR PROJECT

When you are ready to print your project, open the File Menu. The
printing commands are:

Select Colors
Print Options (Explained in Section 8, Special Features.)
Adjust Printing
Print Greeting Card, etc.

SElECT CalORS If you have an ImageWriter 11 or Scribe printer, you can print your Print
Shop project in color with a color ribbon. To print in color, first complete the
design of your project, then choose Select Colors from the File Menu.

Seiet. Colors

@ Front o Inside

@ Text 0 Graph i cs

o Borders 0 Background

@ Black* 0 Purpie 0 Yellow*

o Orange 0 Green 0 Red*

o Blue* * indicates primary color

Canc:el OK
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You can choose to print your text in one color, your borders in another,
and your graphics in a third.

• If you are making a greeting card, first choose your panel, either Front
or Inside.

• If you are making letterhead, choose Top or Bottom.

• Then cl ick the button next to the element - Text, Borders,
Background or Graphics - you want to print in color. Click a color choice.
Repeat this step until you have chosen colors for each design element.

• When you are finished, c1icklf=;;;........,



ADJUST PRINTING The Adjust Printing test lets you check the alignment of your paper. This is
important because if your paper is not aligned praperly, your project will not be
correctly positioned on the page. To perform the paper alignment test:

• Make sure your printer is praperly connected to your computer, power
on and selected.

• Select Adjust Printing. Four corners will be printed on the sheet of paper.
If the corners are centered top and bottom on the page, your paper is praperly
aligned. If they are not centered. re-position the paper and try again.

PRINTING When you are ready to print, select Print. .. fram the File Menu. Make sure
that your printer is turned on and praperly connected. If you are printing on an
ImageWriter I or 11, the computer will set the printing configuration for you.
Otherwise, you can make your choices fram the dialog boxes which will appear
automatically.

To see more print options, hold down the Option key while selecting Print
from the File menu. But a word of caution. Using any of these options may
inadvertantly affect the placement on the page of the praject you are printing,
and give you less than satisfactory results.

When your project has finished printing, you can make another copy if you
wish by selecting Print. .. again.

LASERWRITER HINTS Because the LaserWriter is unable to print as close to the edge of the
paper as an ImageWriter, your greeting cards may not be precisely centered
when you fold them. To compensate for this, you can trim the sides to make
the border even.

Since the LaserWriter prints on individual sheets, when making a banner
you will have to tape the pages together. You should be aware that, sinee
the LaserWriter is unable to print as elose to the edge 01 the paper, a por­
tion 01 your text and graphie at the top and bottom 01 your banner will
not print.
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8. SPECIAL FEATURES

The Print Shop is made so that you can design and print out a project
quickly and easily. Some features are preset to simplify your choices. There
are also some special features that you can use to change your layout and
create special effects in your projects. Experiment with these features to see
what works best for you.

ADDING NEW FONTS You can create your own font file for use with The Print Shop program. To
do this, you will need the Font/DA MoverM program available on the System
Update disk which your Apple dealer can provide.

When using Font/DA Mover:

1. Create a separate file with Font Mover.

2. Add your fonts to the file.

3. Add the font file name to Preferences, located on the File Menu, so
that The Print Shop will know where to find the fonts.

Note: Deleting fonts from your Print Shop Fonts file is not
recommended because you run the risk, once you have done
so, of discovering that you cannot recreate a saved project or
use a ready-made design that uses the fonts you have deleted.
If you have deleted fonts that are used in a Print Shop project,
and you want to use that project again, a dialog box will appear
stating that new fants must be substituted for the deleted
ones.

COPYING A LETTERHEAD
DESIGN TO A MACWRITE

DOCUMENT

Complete your letterhead design. Then select the To-From Clipboard
option from the Graphics Menu and press IKJ A. Your complete design,
including text and graphics, will be copied to the Clipboard. Load MacWrite,
set the desired margins, and paste your letterhead design from the Clipboard
into your MacWrite document.

Note: MacWrite will not be able to accommodate the full width of the
letterhead so it will shrink the design slightly to fit.
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USING TEXT AS A GRAPHIC If you want to create agraphie composed of text for use in your Print
Shop creations, follow these steps:

1. Start in any of the Main Project screens.

2. Type your text.

Note: The only fant that can be used as agraphie is
Chicago.

3. Highlight the text you typed.

4. Select Copy from the Edit Menu to copy this text to the Clipboard.

5. Select To-From Clipboard from the Graphics Menu.

6. Clickl '-GOf"I<- land the text in the Clipboard will be copied to the current
graphie selection.



You can now edit, modity, save, or use this textjust as you would any
other graphie. Note: This type of text-graphie can be especially effective
when used in banners.

SPECIAL PRINT OPTIONS

GREETING CARDS Before you print your greeting card, you can select Print Options from the
File Menu to make some special layout choices. A dialog box will appear with
four layout boxes in it.

Greeting Card Print Op-tions

110-'1 <-- Inside u} rTIOOL-I] <-Front Back-) ID.-J

<-­
<--

Inside --)
Front --) B

Cancel OK D

Printing on Four Panels

A black line surrounds the first box. This is the preset layout for greeting
cards. The inside panel appears on the top left. The front panel appears on
the bottom right.

By clicking one of the other boxes, you can change how your card will
print. The black line will surround your new choice.

For example, if you click rn your inside panel will appear on the top
right-and actually be printed on the left inside panel of your card. The front
panel you design will be printed on the back of your card.

You might want to design and print a card on all four panels. To do this:

1. Design the front and inside panels. Check your paper alignment and
print as usual. Then roll your printed p~r back to its original position.

2. Design two more panels. Click Iill and print. Your panels will appear
on the inside left and back of the card you have already printed. If you want
designs on three panels, simply leave one panel blank.

Click the other two Print Option choices when you want to stretch out
one or both panels. To have an inside panel that stretches to cover both
inside panels of your card, click Ea.
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Your design will look like this:

I""''''''OP
~~&u-u~,... •• , o~ __U'l'"il'"
~~ I ~ 1:JU ~Q,a~

If you click ,both panels will be stretched. However, since you are
printing on only one side of the paper, both panels will be on the outside or
inside of your card. You might want to use this layout for a large placecard with
designs on the front and back.

1\A'--"~

.. '1<H06'U ~ ,: ._oA ~-.-,~. ~,.....
'3"1.& ( .,& ...... oA "0 .._o..,J;:

Ta print on the other side of the sheet of paper, remave the paper from
your printer and turn it over before re-inserting.

Experiment with these layouts to see what kind of interesting and
unusual projects you can create.



BANNERS Banners generally eonsist of one line of full size text and graphies printed
solid like this:

I M Happy Day, Mom! MI
By seleeting Print Options before you print. you will have a ehoiee of

some advaneed layout options.

Grid or Solid Graphies You ean ehoose to have your graphie printed in a grid pattern instead of
the usual solid. Grid adds a bit of spaee between eaeh pixel. It gives your
graphie a distinetive look.

Two Lines ofText You ean also ehoose to print your message in two lines. For example:

HAPPV ANr',J IVERSARV
RAVf"lOND AND DOROTHV!
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PRE-LOADING FONTS,
BORDERS, AND GRAPHICS

In orderto make a banner like this you must print in three steps. You may
need to experiment with choices and paper alignment to get this just right.
Whenever you print a project in several steps, it is a good idea to note where
the edge of your paper is in your printer. Since you will have to roll back the
paper and print again, it helps if you know exactly where you started.

1. Select the butterfly graphie and print as usual. With a pencil, lightly
mark your paper by the roller shaft.

2. Drag the butterfly graphie off your banner window. Type in "Happy
Anniversary." Select Print Options from the File Menu and choose Top Half.
Select Print and your message will print right after your graphie.

3. Clear your banner of text, and roll your paper back so that your roller
shaft lines up with the pencil mark you made. Type in your message for the
bottom line. Select Print Options again but this time choose Bottom Half.
Then select Print.

Experiment to find new ways to use this feature. For example:

• You can add small graphics on the top and bottom line.

• You can stagger text and graphics on the two lines.

• You can use the Pixel Editor to change the patterns of one or both
lines. You can also change the brush shape of one or both lines. But
remember that certain brush shapes may be less legible in the smaller
typestyles used in this option.

If you are using a one-drive system and want to reduce the amount of disk
swapping you will do, you can pre-Ioad The Print Shop's fonts, borders, and
graphics. When you do this, the program will not have to access The Print
Shop 2 disk as often to find the design elements you want to use.

To pre-Ioad, select Preferences from the File Menu. A dialog box will
appear. Click the elements-fonts, borders, or graphics-you want to pre­
load. You mayaiso type in the name of any other font file you want to use.
When you are finished, click OK

The next time you load the program, The Print Shop will pre-Ioad the
elements you selected in Preferences. Note that while time-consuming disk
swapping will be reduced, loading will take considerably longer.

If you added your own font file, it will be pre-Ioaded along with The Print
Shop fonts and will appear on the Font Menu.

Note that if, during operation of The Print Shop, the memory that the pre­
loaded files use is needed, the files will be purged. The Print Shop will reload
files as they are needed.



9. MENUS AT A GLANCE

File Edit Selections Graphics

/
About The Prlnt Shop...

Alnrm Clocle
Chooser
Control Pnnel
Key Cnps
Screpboole

/
ew

Open...
Close
Aeuert
Snue
Snue As...
Preferences ..
Select Colors ..
Pr/nt Options .
Adju t prlnter .
Prlnt Slgn...

Qult

Cut
(opy
Pnste
Cleer
Select RII

Show Clipbonrd

Preulew...

Select Grephits...
To-From Mecpllin"" fIIe...
To-From Cllpboerd•..

Grephlt layout .
Grnphit Editor ..

Silue Grephlts...
Oelete Grephits...

,lftth n
Auent Gnrne
Cniro
Chltego
Courler
Geneun
Heluetlc
london
los Angeles
Monneo

ew Yorle
Son Frnnclsco
Senttle
Times
Toronto
Uenlce
Zepf Chnnce

9 point
10
12
14

.I1lID
20
24
30
ro
48
72

ADDITIONAL KEYBOARD
SHORTCUTS

GRAPHIC EDITOR ~ I inverts the graphie.

~ V flips the graphie vertieally.

~ H flips the graphie horizontally.

MISCELLANEOUS ~ A eopies a eomplete panel to either a MaePaint file or to the
Clipboard.

~ N switehes to no border from the main Greeting Card or Sign
sereens, or while in the Graphie Layout seetion.
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10. ADDITIONAL EXAMPLES

BANNERS

Picnic; july 4

I

~

'Bon 'Vo1jaBe!~
~
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SIGN

Lock

Corporate
flnnual
Report
1986
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